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INTRODUCTION

WORKING WITH SYSTEM 7

Apple is pleased to deliver the Golden
Master release of System 7 software
and Inside Macintosh, Volume V1.

We strongly encourage you to begin
compatibility testing and development
if you haven't already done so. Good
luck with your development projects,
and we look forward to seeing your
great new applications!

For late-breaking news and informa-
tion, see the Change History and
Release Notes file in the Technical
Documentation folder on the CD-
ROM.

Apple is supplying you with this
release of software and documenta-
tion in order to help you:

o Test your existing products to
ensure compatibility with
System 7

e Enhance your existing applica-
tions to use the new
functionality of System 7

e Create new products that take
advantage of System 7 features

Software License

Please read the software license
agreement at the back of this booklet
before using the enclosed CD-ROM.
By using this CD-ROM, you agree to
be bound by the terms and condi-
tions of the license agreement.

First Steps

Once you're up and running under
System 7, Apple recommends that
you do the following:

* Ensure that your applications
work with the Process Manager
(known as MultiFinder®under
System 0).

¢ Make your applications 32-bit
clean.

* Ensure that your applications
are AppleShare®-aware.

* Remove font size restrictions.

¢ Add support for required
Apple®events.

Add Edition Manager capabili-

ties to your application.

e Implement Balloon Help.

¢ Add support for Core Apple
events.

¢ Ensure that your applications
are compatible with virtual
memoty.

Ensure That Your Applications
Work With The Process Manager
To run effectively in the System 7
environment, your application
should be designed so that other
applications can be open at the same
time and can share the available
system resources, such as processing
time, memory, communications
channels, and so on.

Make Your Application 32-Bit
Clean

A 32-bit clean application runs
propetly in an environment where
memory addresses occupy all 32 bits
of handles and pointers. To make
your program 32-bit clean, refrain
from creating your own handles and
from directly setting flags in master
pointers. Also, refrain from reading or
writing directly into the Memory
Manager’s data structures. The



correct way to deal with handles,
master pointers, and Memory Man-
ager parameters is by calling the
Memory Manager.

To make sure your application can
coexist with other applications,
specify a reasonable size for your
program’s memory partition; allow
other programs to use processor
time your application doesn’t need;
and respond to suspend and resume
events so that less time is needed to
switch your application to the
foreground or background.

Ensure That Your Applications
Are AppleShare-aware

With System 7 any Macintosh®
computer connected to a network
can make folders on its hard disk
available to other users on the
network. Any application may end

up being executed in a shared
environment, so developers should
understand the nature of such
environments.

Remove Font Size Restrictions
System 7 introduces Apple’s system
of outline fonts, known as TrueType™
fonts. An outline font can be printed
or displayed in any size without
exhibiting the jagged appearance that
bitmapped fonts take on when they
are enlarged or reduced.

When using an outline font, a System
7-friendly application allows the user
to specify the font size in increments
of one point up to 32,768 points. To
indicate that the font in use is an
outline font, the application should
display all the font sizes in its Size
menu in outline style.

Add Support For Required Apple
Events

The required Apple events are a
minimal set of high-level events that
the system software sends to applica-
tions, which are Open Application,
Open Documents, Print Documents,
and Quit Application. The Finder™
application in System 7 uses the
required Apple events for launching
and terminating applications. You
can modify your program’s main
event loop to support the required
Apple events, thus allowing your
application to coexist with other
applications that support Apple
events.

Add Edition Manager Capabili-
ties To Your Application

The Edition Manager allows your ap-
plications to share data dynamically.
The document that contains the shared

data is called the edition. The area in
the document that contains the
original data is called the publisher;
the area that contains a copy of the
data is called the subscriber. When
the user changes data in the publish-
er and saves the document, the
Edition Manager notifies any open
application that subscribes to the
edition that new information is
available. The application can then
update its subscriber with a copy of
the publisher’s new information.

Implement Balloon Help

When the user selects Show Balloons
from the Help menu, the Help
Manager displays information in
small help balloons as the user
moves the cursor over areas such as
scroll bars, buttons, menus, or parts
of windows.



The Finder displays default help
balloons for menu titles and menu
commands in the Apple menu, Help
menu, and Application menu, and
for the parts of the standard window
frame. The Finder provides default
help balloons for your application
icon and for any documents created
by your applications. You can
customize the help balloon for your
application by providing the appro-
priate resource in your application’s
resource fork.

To take full advantage of Balloon
Help, you can provide help balloons
for your application’s menus, dialog
boxes, and alert boxes by adding
appropriate resources to your
resource fork. You can provide help

balloons for the other parts of your
interface, such as tool palettes and
rulers, either by adding resources or
by using Help Manager routines.

Add Support for Core Apple
Events

Core Apple events are standard
Apple events that apply to all or
nearly all applications. For example,
the Apple events for selecting data in
a document and for inserting data
into a document are core Apple
events.

Degrees of System 7 Compatibility
Macintosh applications can be
classitied by how much they interact
with the new features of System 7.
Applications can be 7-compatible,
7-friendly, or 7-dependent.

7-Compatible

These applications do not take
advantage of any new features. They
run under System 7 the same as they
do under eatlier versions of the
system software,

7-Friendly

Although these applications can

run under earlier versions of the
system software, they take advantage
of the special features of System 7
whenever they are running under
that version.

7-Dependent

These applications require the
special features of System 7 to do
their jobs and cannot run effectively
under earlier versions of the system
software.

For additional information on what
you must do to update and create
applications that support System 7
and existing platforms and systems,
see the Sample Code folder on the
CD-ROM.



SETUP AND

INSTALLATION

The following sections contain
helpful information about using the
CD-ROM. They cover system
requirements, installation proce-
dures, and the contents of the disc.

Apple recommends that you use
the following basic tools with this
CD-ROM:
e A hard disk
o System Software version 6.0.3
or later
* An AppleCD SC®drive or
equivalent third-party CD-ROM
drive
¢ Apple CD-ROM software
version 2.0 or later (Note: The
Macintosh Iici and Ilfx require
version 3.0.1 or later of the
CD-ROM software.)

System Configuration
Apple recommends the following
system configuration for System 7:

¢ A hard disk and a minimum of
four megabytes of memory for
development purposes. System
7 will run on all Macintosh
computers, beginning with the
Macintosh Plus, with at least
two megabytes of memory
and a hard disk. To use virtual
memoty, you must have a
Macintosh equipped with a
68030 processor or 68020
processor with a Page Memory
Management Unit (PMMU).
Virtual Memory is not supported
on the Macintosh SE, Portable,
Classic®or Plus.
An AppleCD SC drive or equiva-
lent third-party CD-ROM drive
with the Apple CD-ROM soft-

ware version 3.0.2 or later. If
you are using an eatlier version,
you can easily upgrade to the
latest version, which is available
on the AppleLink®network as
well as on this CD-ROM. (Note:
The CD-ROM software requires
System Software version 6.0.3
or later.)

* HyperCard® available on the
CD-ROM.

Using the CD-ROM

First, turn on your CD-ROM drive,
and then turn on your Macintosh.
Next, place the System 7 CD-ROM
into a CD-ROM caddy and insert the
caddy into your CD-ROM drive. After
your Macintosh boots, you should
see the System 7 CD icon on your
desktop.

If you have problems mounting the

CD-ROM, check the following:

¢ Was the CD-ROM drive turned
on before you turned on your
Macintosh?

* Are all the SCSI cables configured
correctly, and are they secure?

* Are there any SCSI ID conflicts?

* Do you have proper SCSI termina-
tion? The Macintosh IIfx uses a
different terminator than earlier
Macintosh models.

* Did you install the proper drivers
and then restart your machine?

If you still cannot get the icon to
appear, refer to your CD-ROM drive
owner’s manual for more trouble-
shooting information.

(Note: The System 7 CD-ROM can
also be mounted as a volume on an
AppleShare file server to allow several
people in your company to share the
single CD-ROM.)



SETUP AND INSTALLATION

Once you have the System 7 CD
mounted on your desktop, open the
Open Me First folder, then double-
click the Read Me First icon. Read Me
First is a TeachText document that
introduces you to the contents of the
CD-ROM.

To navigate through the documen-
tation, you need HyperCard on your
hard disk. Use of HyperCard is
subject to certain copy restrictions
as noted in the software license
agreement.

You must first create a floppy disk
version of HyperCard from the disk
image on the CD-ROM. Open the
HyperCard folder on the CD-ROM
and follow these steps:

1. Double-click the HyperCard
image icon. This action launch-
es DiskCopy and loads the
HyperCard disk image into
memoty.

2. Click the Start Copy button.
3. Insert a blank floppy disk into
any disk drive.

When DiskCopy finishes writing and
verifying the copy, it ejects the floppy
disk and waits for another. Since you
need only a single copy, proceed to
the next steps:

4. Click the Stop Copy button.

5. Quit DiskCopy by choosing

Quit from the File menu.

You now have HyperCard on the
floppy disk. Copy the application and
the Home Stack to your hard disk.

Installing System 7

Under no circumstances should you
install Golden Master System 7 on top
of an earlier beta version of System 7.

Installing System 7 From the
CD-ROM
Open the System Software 7 folder
and then open the Installer Version
folder. Double-click the Installer icon
to launch the Installer. The Installer
gives you the option of installing on
the current disk, switching disks, or
customizing the installation. If you
choose the default installation—Easy
Install—you'll get the following:
o System Software 7
e Update to any existing printing
software
o Update to any existing network
software such as EtherTalk®
o AppleShare client software
o FileSharing software

You can also configure the installa-
tion for your particular machine. If
you decide to customize the install-
ation, make the appropriate choices
and then click the Install button.

Once the installation is finished,
the Installer presents a dialog box
that allows you either to continue
installing system components or to
quit the Installer. If you are satisfied
with the configuration, click the Quit
button to return to the Finder. Then
restart your Macintosh. (Note: If you
install System 7 on an external disk
drive, you may have to reset your
Startup Device from the Control
Panel.)

Installing System 7 From

Floppy Disks

To install System 7 from floppy
disks, you must first create floppy
disks from the disk images on the
CD-ROM. Open the System Software
7 folder and then open the Disk
Image Version folder. Double-click
the Install 1 image icon to launch
DiskCopy and load the disk image



SETUP AND

into memory. Proceed as follows:
1. Click the Start Copy button.
2. Insert a blank floppy disk into
any disk drive.

When DiskCopy finishes writing and
verifying the copy, it ejects the floppy
disk and waits for another.
If you need only a single copy,
proceed to the next step.
3. Click the Stop Copy button.
4. Choose Load Disk Image from
the File menu.
5. From the standard file dialog
box, choose the next disk image
to copy.

After DiskCopy loads the disk image
you choose into memory, repeat the
preceding steps, beginning with
clicking the Start Copy button, for
each of the remaining disk images.
When you have copied the final disk

®

INSTALLATION

image, exit DiskCopy by choosing
Quit from the File menu.

You now have System 7 installa-
tion disks. After labeling them, restart
your machine with the Install 1 disk.
After your Macintosh boots, open the
Install 1 disk and double-click the
Installer icon to launch the Installer.

The Installer gives you the option
of installing on the current disk,
switching disks, or customizing the
installation (you can get Help by
clicking the Help button). If you
choose the default installation—Easy
Install—you'll get the following:

e System Software 7

e Update to any existing printing

software

* Update to any existing network

software such as EtherTalk

o AppleShare client software

¢ FileSharing software

You can also configure the installa-
tion for your particular machine. If
you decide to customize the installa-
tion, make the appropriate choices
and then click the Install button.

The Installer determines which
disks it needs for the installation and
begins the installation procedure.
When it needs another disk, it
prompts you. Once the installation
is finished, the Installer presents a
dialog box that allows you to either
continue installing system compo-
nents or to quit the Installer. If you
are satisfied with the configuration,
click the Quit button to return to the
Finder. Then restart your Macintosh.
(Note: If you install System 7 on an
external disk drive, you may have to
reset your Startup Device from the
Control Panel.)



CONTENT OVERVIEW

Following is an overview of the System Software 7

System 7 CD-ROM folder structure ¢ Installer Version—Contains the

and contents: necessary files to install System
7 directly from the CD, even
from an AppleShare file server.

* Disk Image Version—Contains
the DiskCopy images of the
System 7 floppy disks.

Open Me First
¢ Read Me First—TeachText
document that introduces you to
the CD-ROM and its contents. It
also gives basic information on
getting started. System 7 Development Tools
e CD Index—An index of the o MPW®Shell—Contains the
entire CD-ROM. MPW (Macintosh Programmer’s
e Software License Agreement. Workshop) 3.2 Shell. If you use
MPW under System 7, this
version of MPW is required for
compatibility.
o MPW Interfaces—Contains the
MPW interfaces and libraries
necessary to build System 7
applications using MPW 3.1 or
3.2 compilers.

» THINK Interfaces—
Contains the System 7
interfaces for THINK C and
THINK Pascal compilers;
new libraries for THINK C;
patches to the THINK C
and THINK Pascal environ-
ment; and a THINK C
debugger that works with
System 7.
MacsBug—Contains the
latest version of MacsBug,
which you can use to
debug your System 7
applications.

ResEdit™— Contains
ResEdit v2.1, which has
editors for some of the new
resource types supported
in System 7.

* SADE® (Symbolic
Application Debugging
Environment)—Contains a
release of SADEv1.3 for
MPW, which is compatible
with System 7.

* BalloonWriter—Contains a

release of BalloonWriter

v1.0. This application
makes it easier to add
balloon help to your
applications.

Lisp Interfaces—Contains

System 7 interfaces for

Macintosh Common Lisp.
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Sample Code
¢ Contains System 7-compati-
ble sample code, which is
explained and documented
in the Read Me files that
accompany each sample.

Inside Macintosh
e [Inside Macintosh, Volume
VI: Online Edition—
Contains Inside Macintosh,
Volume VI, with dynamic
linksbetween the text and
the System 7 Interfaces.
¢ Viewer Version— Contains
Inside Macintosh, Volume VI, in
Viewer format, which allows
you to print the documentation
in book format.
Splnside Macintosh—Contains
the HyperCard version of Inside
Macintosh, Volumes I through
V, and is cross-referenced with
the Technical Notes Stack and
the Q&A Stack.

D

¢ Technical Notes Stack—Con-
tains all the Macintosh Technical
Notes in HyperCard format.
Technical Notes expand on and
clarify the technical information
found in Inside Macintosh; they
also offer new programming
tips and techniques not found in
other Apple technical manuals.
(Note: The Technical Notes

Stack is not specific to System 7 )
Q&A Stack—Contains answers
to the most frequently asked
development questions; refer-
encing it can save valuable
development time. (Note: The
OGA Stack is not specific lo
Sysiem 7.)

Delta documentation—Contains
updates to information in Inside
Macintosh, Volume V1.

HyperCard
* HyperCard image—Disk
Copy document that contains
exact copies of HyperCard and
the Home Stack.

Utilities

* CD-ROM—Contains version
3.0.2 of the Apple CD-ROM
software.

* DiskCopy—Contains the Disk-
Copy application and documen-
tation. DiskCopy is used to
create, save, and copy floppy
disk images.

* Outside Bug Reporter—Applica-
tion used to report bugs to
Apple.

* AppleLink—Application used
to print the Viewer-format
documents contained on the
CD-ROM.

o TeachText—Application used to
create and read simple text files.

7]

User Documentation
* Contains end-user documenta-
tion which will help answer
many of your general System 7
questions.

System 7 Goodies
* Contains additional sample
programs, debugging tools, and
testing tools.



SOFTWARE LICENSE AGREEMENT

Apple Computer, Inc. Software License Agreement

PLEASE READ THIS LICENSE CAREFULLY BEFORE USING THE SOFTWARE. BY USING THE SOFTWARE,

YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS LICENSE. IF YOU DO NOT AGREE TO THE

TERMS OF THIS LICENSE, PROMPTLY RETURN THE UNUSED SOFTWARE TO THE PLACE WHERE YOU
OBTAINED IT AND YOUR MONEY WILL BE REFUNDED.

1. License. The application, demonstration, system and other software accompanying this License, whether
on disk, in read only memory, or on any other media (the “Software”) and related documentation are li-
censed to you by Apple. You own the disk on which the Software is recorded but Apple and/or Apple’s
Licensor(s) retain title to the Software and related documentation. This License allows you to:

(a) with respect to the Software, except the HyperCard program, copy the Software either over a network or

onto diskettes for use on Apple Macintosh computers provided all such computers are within your Site. *Site”

is generally defined as the following: (i) Higher Education: All students, faculty, and administration at the

university/college campus. (ii) K-12: One or more schools that make up a single school district. (iif) Business:

All of a division’s locations within a 25-mile radius. (iv) Government: All of an agency’s/department’s loca-
tions within a 25-mile radius.

(b) with respect to the HyperCard program (*HyperCard”) you may make up 10 a maximum of 20 copies of
HyperCard for use within your Site. For the purposes of calculating the total number of copies of HyperCard
permitted to be made under this License, a copy of HyperCard operating on either (i) a single CPU or (ii) a
single CPU shared by multiple CPUs (“Server”) where HyperCard is executed from a single copy of Hyper-
Card on the Server shall constitute one copy. For more information on the HyperCard software license,
please contact Claris Customer Relations at 1-408-727-8227.

(¢) make one copy of the Software in machine-readable form for backup purposes.

(d) perform the above provided you reproduce on such copies all copyright notices and any other propri-
etary legends that were on the original copy of the Software.

() transfer all your license rights in the Software and the related documentation to another party provided
the other party reads and agrees to accept the terms and conditions of this License.

18]

2. Restrictions. The Software contains copyrighted material, trade secrets, and other proprietary information
and in order to protect them you may not decompile, reverse engineer, disassemble or otherwise reduce the
Software to a human-perceivable form. You may not modify, network, rent, lease, loan, distribute or create
derivative works based upon the Software in whole or in part.

3. Termination. This License is effective until terminated. You may terminate this License at any time by
destroying the Software and related documentation and all copies thereof. This License will terminate imme-
diately without notice from Apple if you fail to comply with any provision of this License. Upon termination
you must destroy the Software and related documentation and all copies thereof.

4. Export Law Assurances. You agree and certify that neither the Software nor any other technical data
received from Apple, nor the direct product thereof, will be exported outside the United States except as
authorized and as permitted by the laws and regulations of the United States.

5. Government End Users. If you are acquiring the Software on behalf of any unit or agency of the United
States Government, the following provisions apply. The Government agrees: (i) if the Software is supplied to
the Department of Defense (DoD), the Software is classified as “Commercial Computer Software” and the
Government is acquiring only “restricted rights” in the Software and its documentation as that term is defined
in Clause 252.227-7013(c)(1) of the DFARS; and (ii) if the Software is supplied to any unit or agency of the
United States Government other than DoD, the Government's rights in the Software and its documentation
will be as defined in Clause 52.227-19(c)(2) of the FAR or, in the case of NASA, in Clause 18-52.227-86(d) of
the NASA Supplement to the FAR.

6. Limited Warranty on Media. Apple warrants the disks on which the Software is recorded to be free from
defects in materials and workmanship under normal use for a period of ninety (90) days from the date of
purchase as evidenced by a copy of the receipt. Apple’s entire liability and your exclusive remedy will be
replacement of the disk not meeting Apple’s limited warranty and which is returned to Apple or an Apple
authorized representative with a copy of the receipt. Apple will have no responsibility to replace a disk
damaged by accident, abuse or misapplication. ANY IMPLIED WARRANTIES ON THE DISKS, INCLUDING
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE
LIMITED IN DURATION TO NINETY (90) DAYS FROM THE DATE OF DELIVERY. THIS WARRANTY GIVES
YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM STATE

TO STATE.
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7. Disclaimer of Warranty on Software. You expressly acknowledge and agree that use of the Software is
at your sole risk. The Software and related documentation are provided “AS IS” and without warranty of any
kind and Apple EXPRESSLY DISCLAIMS ALL WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. APPLE DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE APPLE SOFTWARE
WILL MEET YOUR REQUIREMENTS, OR THAT THE OPERATION OF THE APPLE SOFTWARE WILL BE
UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE APPLE SOFTWARE WILL BE CORRECTED.
FURTHERMORE, APPLE DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS REGARDING THE USE
OR THE RESULTS OF THE USE OF THE APPLE SOFTWARE OR RELATED DOCUMENTATION IN TERMS
OF THEIR CORRECTNESS, ACCURACY, RELIABILITY, OR OTHERWISE. NO ORAL OR WRITTEN INFOR-
MATION OR ADVICE GIVEN BY APPLE OR AN APPLE AUTHORIZED REPRESENTATIVE SHALL CREATE A
WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY. SHOULD THE APPLE SOFT-
WARE PROVE DEFECTIVE, YOU (AND NOT APPLE OR AN APPLE AUTHORIZED REPRESENTATIVE)
ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. SOME STATES
DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT
APPLY TO YOU.

8. Limitation of Liability. UNDER NO CIRCUMSTANCES INCLUDING NEGLIGENCE, SHALL APPLE BE
LIABLE FOR ANY INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES THAT RESULT FROM THE USE
OR INABILITY TO USE THE APPLE SOFTWARE OR RELATED DOCUMENTATION, EVEN IF APPLE OR AN
APPLE AUTHORIZED REPRESENTATIVE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.
In no event shall Apple’s total liability to you for all damages, losses, and causes of action (whether in con-
tract, tort (including negligence) or otherwise) exceed the amount paid by you for the Software.

9. Controlling Law and Severability. This License shall be governed by and construed in accordance with
the laws of the United States and the State of California, as applied to agreements entered into and to be
performed entirely within California between California residents. If for any reason a court of competent
jurisdliction finds any provision of this License, or portion thereof, to be unenforceable, that provision of the
License shall be enforced to the maximum extent permissible so as to effect the intent of the parties, and the
remainder of this License shall continue in full force and effect.

10. Complete Agreement. This License constitutes the entire agreement between the parties with respect to
the use of the Software and related documentation, and supersedes all prior or contemporaneous under-
standings or agreements, written or oral, regarding such subject matter. No amendment to or modification of
this License will be binding unless in writing and signed by a duly authorized representative of Apple.

©1991 Apple Computer, Inc.

Apple, the Apple logo, AppleCD SC, AppleLink, AppleShare, EtherTalk, HyperCard, Macintosh, MPW,
MultiFinder, and SADE are registered trademarks of Apple Computer, Inc. Classic is a registered trademark
licensed to Apple Computer, Inc. Finder, ResEdit and TrueType are trademarks of Apple Computer, Inc.
I'HINK C and THINK Pascal are trademarks of Symantec Corporation.

21




